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If you are not satisfied with any Gopher purchase for any  
reason at any time, contact us and we will replace the  
product, credit your account, or refund the purchase price.

Read instructions in their entirety. In the event of missing parts, call 1-800-533-0446.

Thank you for purchasing this product from Gopher.

Operating System Requirements

Item Minimum Recommended

Operating System Mac® OS X® 10.9 Mavericks Mac® OS X® 10.11 El Capitan

Processor Intel® Core™ 2 Duo, Core™ i3, Core™ i5, Core™ i7, or 
Xeon® Processor

Same

Memory Capability 2 GB Same

Free Hard Drive Space 100 MB (including installed program and database) 500 MB (including installed program and database)

Installing the Software

To download the FITstep™ software, go to www.gophersport.com/software. Click on the Mac Version 3 User Software Download, 
follow the prompts to install. 

Drag the FITstep™ Pro logo to the Applications folder. As part of the installation process, any data you collected with the first version 
of the software is converted to work with the new version. It is not necessary to re-enter student names, pedometer number, or 
classes. Also it is important to note, that the installation process will create a backup file that you can use with your older version of the 
FITstep™ software. 

Using the Software Menu

The screen pictured on page 2 appears when the software opens. The components in the menu bar are used for file operations, 
printing, and importing/exporting data. 

The screen is divided into two major parts. The left window is hierarchical and breaks down by instructor to grades to classes to 
students. To make the next level appear, double click on the top level tile or click on the triangle to the left of the name. The right 
window is the main viewing window; class/student information is entered here, full class lists are shown, and uploaded data can be 
viewed. To use any of the tabs on the right side of the screen, a class must be selected.  

It is possible to utilize the Reports Tab function with more than one instructor, student, class, and/or grade by holding the command 
key down and clicking the names of the desired items. 

Mac® Software Manual for FITstep™ Pro 
Version 3

http://www.gophersport.com/software
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FILE MENU

Database

The database houses all information from the FITstep™ software. It is recommended to store the database on the computer desktop 
for easy access. 

All FITstep™ databases are stored as *.db files. 

Opening an Existing Database

If you used previous versions of the software, your database file will convert so it works with the new software. If you use multiple 
databases or want to open one you converted from the old software, use the following steps:

1. File

2. Open Database

3. A finder window will open and allow you to search for your desired database. Select the database and click Open. 

New Database

If you have not previously stored pedometer data using an earlier version of the software, complete the steps below to create a new 
file in which you will store data. If this is the first time you have used the software or if it cannot find your database, it will create a new 
one with the name Untitled.db. 

NOTE: If working with other teachers using the same computer, each should create a personal database. This will allow each user 
to open his/her database when he/she is ready to collect data or print a report. It is possible for multiple teachers to share the same 
database, but it gives all teachers access to the others’ data. An advantage is that students can be easily moved from one teacher to 
another. 
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Follow these steps to create a new database:

1. File

2. New Database

3. Select the location you wish to store the database (desktop is recommended.)

4. The software will prompt you to name the database. 

5. Select Create new FITstep Database. 

Once database is located or created, proceed to Reader Setup Instructions. 

Reader Setup

The reader allows for data transfer from the FITstep™ Pro pedometer to the FITstep™ 
software. 

1. To set up the reader, plug the reader into the computer using the provided USB 
cord. 

2. The computer will automatically connect to the reader. 

3. The FITstep™ software will register the reader as indicated in the lower left hand 
corner. 

TABS

Pedometer Setup

The Pedometer Setup Tab has one purpose: to embed a number in the pedometer. 
Embed pedometer numbers before using them with students. Here is the suggested 
procedure for numbering the pedometers if you have a new set:

1. Number the pedometers on the outside and inside of the pedometer covers. This 
will make it easy for students to identify their pedometer each time they come to class. It is probably easiest to start with 
pedometer 1 and number from that point forward. However, numbering can be started at any integer. 

2. Pedometer may be in a deep sleep mode to conserve battery life. To wake the pedometer, press and hold the reset button until 
the screen comes on. 

3. Click the Pedometer Setup tab. Click on the “write new number” box. Set the new pedometer number to the desired starting 
number. For example, if you set the new number to 1, that pedometer will be internally assigned to number 1. 

4. Select the first pedometer you wish to number, open the pedometer and place it screen side up into the reader. 

5. The software will register the pedometer and assign it with the number identified. 

6. The software will automatically change the next pedometer number to the next integer. You are now ready to open the next 
pedometer and place it into the reader. 

7. To check whether the correct number has been assigned to the pedometer, press the Mode button on the pedometer until 
the Step screen is showing. Now hold down the Set button to see the pedometer number. It will appear as P=00001 if you 
embedded number 1. 

NOTE: nothing will show on this screen if the pedometer has not been numbered. 

8. To manually change a pedometer number, check the “Write New Number” box and type in a new number. Open the front 
cover of the pedometer, place it face down into the reader and the new number will be assigned. A pedometer number can be 
changed using only the Pedometer Setup Tab. 

Class Setup

The Class Setup Tab serves as the control center where you will add new instructors, grades, classes, and students. Not all fields will 
need to be filled, such as the instructor number and description fields. Notice how the data is organized. The top field is the instructor, 
usually the Physical Education teacher. Next is Grade followed by Class Name, which might be listed as a classroom teacher in an 
elementary school or as a class number in secondary schools (for example 3rd Period). If desired, type a description of the class with 
information that might be relevant. Finally, in the last section add the students by first and last name, gender (optional), and pedometer 
number. If desired, a student ID can also be added. 
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Manual Entry Class Setup

Teachers, students, and classes can be entered into the FITstep™ software manually by typing the information into each specific field. 

Import Students into Class

The Import/Export menu offers the opportunity to import students into the FITstep™ software using a spreadsheet. 

NOTE: Data can only be uploaded from an Excel 2007 or higher (.xlsx) workbook. Multiple classes can be stored in the same workbook, 
but each class must be in a separate worksheet. The worksheets do not need to be named, however naming them makes it easier to 
identify different classes that exist in the same spreadsheet. 

The workbook should be set up in columns as follows: First Name, Last Name, Gender, Pedometer Number, and Student Number (see 
example below). 

NOTES:

 • Data cannot be imported unless a first and last name is provided. 

 • Pedometer numbers must be integers greater than zero. 

 • The software will accept gender identifiers of “Male”, “M”, “Boy”, or “B” for males. 

 • The software will accept gender identifiers of “Female”, “F”, “Girl”, or “G” for females. 

 • The student number field is available for adding student IDs or another unique identifier. This field accepts characters and 
numbers. 

 • Columns do not need to be in any particular order. 
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Export Full Database to Excel

The Import/Export menu also allows you to place all data into an Excel workbook. The created workbook will contain five worksheets 
for instructors, grades, classes, students, and workouts. This command should not be used for backing up data since once it is 
exported to Excel, it cannot be imported back into the FITstep™ software. The primary purpose for this command is to do further 
statistical analysis in Excel. 

Upload Pedometer Data

The software works with the FITstep™ Pro data readers. The reader quickly uploads the data (about 1.5 seconds) per student. Multiple 
readers are useful because a large class can be uploaded rapidly. You must plug readers into a USB port on your computer. If you 
need to use multiple readers, a USB hub is recommended. The number of readers actively connected to your computer is listed in the 
bottom left of the screen. 

NOTE: Ensure that each student clears his/her pedometer prior to beginning the class activity. This is done by pressing and holding the 
Yellow Reset button. Pedometers do not automatically clear data from previous uses. 

1. Select the class on the left hand side of the screen. 

NOTE: Data cannot be transferred from class to class. 

2. Select the Upload Pedometer Data tab. 

3. Students open the front cover of the pedometer and place it screen side up into the reader. 

4. As data is uploaded, the red and green lights on the reader will flash and students’ names in the left window will change color 
and re-sort as shown in the screenshot below. The color of a student’s name offers the user the following information:

Black Font: students have not put their pedometer into the reader. 

Green Font: data was successfully uploaded. 

Red Font: data upload was unsuccessful. This may occur when the student does not leave the pedometer in the reader long 
enough for the data to upload. 

Blue Font: uploading process is in progress. 

5. When uploading is complete, only the red light stays solidly lit. 

NOTE: The key to successfully uploading data is to leave the pedometer in the reader until the red and green lights stop flashing. 
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Recommended for Upload

Be sure to check the total number of workouts recorded at the bottom of the screen. This number should match the number of 
students present during the session. A pop-up box will appear when switching from class to class showing any unsuccessful data 
uploads. 

Any student that is present and his/her name remains black or turns red due to an erroneous read, simply needs to put the pedometer 
back into the reader to successfully upload data. 

REPORTS
The Reports Tab is the data analysis center. Click on the Reports Tab to see different types of reports. All of the reports can be sorted 
and then printed, and different columns can be selected by checking the boxes on the right side of the screen. The columns can be 
reordered by dragging a column to the desired location. 

Sorting: The default order of sort is by name in ascending order. To sort any column in descending order, click on the title of the 
column you want to sort and order will be reversed. Click it again and it will return to ascending order. Sorting will move entire rows, 
not just the column you clicked on. 

Date Range: You may choose the date range for all reports. Click on the Date Range indicators in the top right corner of the Reports 
tab. The date may be entered manually, or selected using the calendar button. Select your desired date range, i.e. if you wish to view 
only May 1 to June 1, select those start and end dates. 

NOTE: it is not possible to select dates for the Class Roster report. 

Columns: Select the columns you wish to show in your reports. 
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Brief Description of Reports

Students can upload their data multiple times during the day. When the program calculates daily average for each student, it will add 
together all uploads accumulated in a single day. To preview reports before printing, click on the file menu and select Print. 

1. The Workouts report shows all uploads for each student. Every time a student uploads data, it is stored as a workout. 

2. The Quick Summary report offers a summative view for each class or classes. This is an excellent report for comparing 
students, classes, grades, and instructors. 

3. The Weekly Summary report shows each student and his/her workouts by week. This allows you to analyze students and your 
lessons on a week-by-week basis. 

4. The Monthly Summary report shows each student and his/her monthly totals and averages. 

5. Class Roster gives you the opportunity to print a list of your students by class. You can print a number of classes per print job by 
command-clicking on selected classes. 

6. Physical Activity report allows you to print out a “My Physical Activity Report” for each student. The report contains a message 
to parents and students along with the selected activity sheet (see below). Customize Activity Report command allows for 
customization of the physical activity report to suit your preferences. The options that can be changed are:

a. Edit Report Title

b. Edit Intro Paragraph

c. Change the School Logo

d. Add Logo to Report

There is also a preview selection to allow for a quick look at changes made to the report. 
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Print Reports

The print function is listed under the File menu. It is available when students have been selected and the data is listed on the screen.

Click on the print command to see a preview of your report. If you are satisfied with the report, click on the print icon to print the 
report. If not, cancel the report and filter the data as preferred.

Another feature of the Report Viewer is that the report may be saved in many different formats, including PDF or Word Document. 
To do so, click on the triangle to the right of the disc (see arrow) on the command bar of the report and pull down to your desired 
formatting.
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Export Report to Excel

A report may be exported to Excel by selecting this option under the File menu. This allows any report chosen to be exported into an 
Excel spreadsheet. The spreadsheet will be stored in the same folder where the data file is stored. If the file hasn’t been moved since 
startup, it will be stored in the folder, c:\ProgramData\Gopher\FITstep\.

General Report Help

All the reports generally function in a similar fashion. You pick the students to report on from the class tree on the left side of the 
main window. You can select the instructor, grade, class, or student level. Remember that the Command Key can be used to select a 
number of distinct items in the tree or the Shift Key to select ranges of data. Next, select a date range for the report. The report can be 
customized by selecting options that are available on the right hand side of the main window. Finally, click on the column name to sort 
the data. The first click will sort the data in ascending order, the second click will sort in descending order and the next click will return 
the data to its original order. 

After selecting the students/classes/grades/instructors and report features, print the report by selecting “Print Report” from the File 
menu. This generates a separate report viewer window. From this window it is possible to print the report to a printer, view formatted 
pages on screen, or export the report to one of several file formats. To print, simply click on the printer icon and follow the steps in 
the printer setup menu. Use the navigation arrows to scroll through the report. The file can also be saved to any of the following file 
formats: Acrobat (PDF) File, CSV (comma delimited), Excel Worksheet, PowerPoint Presentation, Rich Text Format (RTF), TIFF File, 
Web Archive, Word Document, or XPS Document. 

It is possible to “Print from Excel” from the File menu. This creates an Excel 2007 format worksheet that has the data items that are 
selected for the report. The Excel file that is created is a data dump of items that you have selected in the order you have chosen. 
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Preferences Menu

The Options Menu allows the user to set some defaults for the software. 

Select Start Date. This option is used for selecting a starting date for creating reports and screen analysis of data. This command 
dictates what the starting date will be when the software is launched. It will always start at one of the options listed below until the 
setting is changed. The following date range options may be selected:

Today – defaults to today.

Yesterday – defaults to yesterday. 

Current Week – defaults to Sunday of the current week. 

Current Month – defaults to the first day of the current month. 

Current Year – defaults to January 1 of the current year. 

Last Week – defaults to Sunday of the previous week. 

Last Month – defaults to the first day of the previous month. 

Fixed Start Date – defaults to a fixed date that is selected. This day will not change until you adjust it. You can use this feature 
to set the default date to the start of the current term, if desired. 

Custom Start Date – allows data to be viewed from a certain number of days, weeks, months, or years. Select the time 
period (days, weeks, months, years) to go back and then select the number of time periods you wish to go back. When using this 
option, you will not necessarily go back to the start of a week, month, or year. When going back by weeks, it will default to the 
same day of the week as today. When going back by months, it will default to the same day of the month as today. Finally, when 
going back years, it will default to the same day of the current month in the previous year. 

After choosing an option, click OK to verify the selection or click Cancel to abort any changes. The next time the Reports tab is 
selected, the start date for the reports will default to the option selected. 

Show Advanced Data Options. This option can be used to check the amount of time students spent in each of the steps per minute 
levels. The FITstep™ Pro pedometers show how much time was spent at each SPM levels (80 to 160 steps per minute). By selecting 
the advanced data option, this data can be reviewed. 

NOTE: This feature only works when viewing the Workouts tab in Reports. 

Customize Activity Reports. This option works on the Physical Activity report and can be used to customize reports. It allows 
changes to be made to the Physical Activity report to suit the school preferences. The changes can be reviewed using the preview 
selection. 

The options that can be changed are:

 • Edit Report Title

 • Edit Intro Paragraph

 • Change School Logo

 • Add Logo to Report

Help Menu

The Help Menu provides easy access to the FITstep™ Software instructions for reference during use. Additional information can be 
found by following the Gopher Sport Web Links. 

Future updates to the FITstep™ Software will be available for download at www.gophersport.com/software.

http://www.gophersport.com/software

